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Getting Started 
This guide shows you how to set up your PC with GoToMyPC and access it from another 
computer. It also explains the main features of GoToMyPC so that you can begin working 
quickly. 

System Requirements 
 
Host PC 

 Microsoft® Windows® 2000 or newer 

 Internet Explorer® 5.0 or newer; Firefox® 1.0 or later or Netscape® 7.0 or newer 

 "Always on" Internet connection (cable, ISDN, DSL or better) 

Client Computer: Viewer for Windows - Full Features 

 Microsoft Windows 95 or newer 

 Recommended: Microsoft Windows 2000 or newer 

 Internet Explorer 5.0 or newer; Firefox 1.0 or newer or Netscape 7.0 or newer 

 Recommended: The connection process is easier if Java™ is installed and the Web 
browser supports Java 

Client Computer: Universal Viewer for Windows - Limited Features 

 Microsoft Windows with Internet Explorer 5.0 or newer, Firefox 1.0 or newer or Netscape 
7.0 or newer; and Microsoft Java or Sun Java 

 Recommended: The Sun Java™ 2 Standard Edition (J2SE) version 1.4 or newer 

Client Computer: Universal Viewer for Mac® - Limited Features 

 Mac OS X with Safari™ 1.0 or newer or Firefox 1.0 or newer; and Sun Java 

Client Computer: Universal Viewer for Linux and Solaris™ - Limited Features 

 Firefox 1.0 or newer or Netscape 7.0 or newer; and Sun Java 

Client Computer: Universal Viewer on other platforms - Limited Features 

 Other operating systems and browsers that support Java and have a full Java 2 Standard 
Edition JVM should work but have not been tested 

Client Computer: PocketView™ for Windows CE™ - Limited Features 

 Microsoft Windows Mobile™ 6.0 Classic and Pro 

 Microsoft Windows Mobile 5.0 for Pocket PC or Pocket PC Phone Edition 

 Microsoft Windows Mobile 2003 or 2003 SE for Pocket PC or Pocket PC Phone Edition 

 Most devices running Microsoft Windows CE 4.0 or later with a touch screen or mouse 
(such as thin clients) 

 Internet Explorer, Pocket Internet Explorer, or equivalent web browser 

Note: Windows Mobile versions that lack a touchscreen are not supported.  This includes Windows Mobile 6.0 Standard, 
5.0 for Smartphones and 2003 / 2003 SE for Smartphones. 
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Feature Requirements 
 
 

Host 95, 98 
and ME NT 4.0 2000 XP (32) XP (64) Server 

2003 (32)
Server 

2003 (64)
Vista 
(32)

Vista 
(64)

Screen Sharing v5.0 v5.0
Multi-Monitor Support v5.0 v5.0
Desktop Shortcut v5.0 v5.0
File Trans fer v5.0 v5.0
File Sync
Drag and Drop
Native Printing v5.0 v5.0
GoToMyPC Printer
Sound v6.1 v6.1

 Brow s er Requirem ents : Internet Explorer 5.0 or new er y Netscape 7.0 or new er y Firefox 1.0 or new er

Not supported
v.5.0 Supported in v5.0 but not v6.0

Supported
New in v6.0

Client 95, 98 
and ME NT 4.0 2000 XP (32) XP (64) Server 

2003 (32)
Server 

2003 (64)
Vista 
(32)

Vista 
(64)

Screen Sharing
Multi-Monitor Support
Desktop Shortcut
File Transfer
File Sync
Drag and Drop
Native Printing
GoToMyPC Printer
Sound

 Browser Requirements: Internet Explorer 5.0 or new er y Netscape 7.0 or new er y Firefox 1.0 or new er

Mobile 
5.0-6.0¸

Mobile 
2003 / SE¸

CE 4.0 & 
newer¸¸

Screen Sharing
Multi-Monitor Support
Desktop Shortcut
File Transfer
File Sync
Drag and Drop
Native Printing
GoToMyPC Printer
Sound
¸    Window s Mobile versions that lack a touchscreen
     are not supported
¸¸ Window s CE 4.0 or new er w ith a touch screen or 
     mouse, such as thin client devices are supported

Windows

PocketView
Universal Viewer Mac 

8.6+
Mac 

10.3.9
Mac 
OS X Linux Solaris

Screen Sharing ¸ ¸¸ ¸

Multi-Monitor Support ¸ ¸¸ ¸

Desktop Shortcut ¸ ¸¸ ¸

File Transfer
File Sync
Drag and Drop
Native Printing
GoToMyPC Printer
Sound

    Sun Java 1.4 Standard Java Virtual Machine Recommended

*  Untested but should w ork w ith the proper JVM

Browser Requirements: Sun Java 1.1 Standard Java Virtual Machine

Internet Explorer  5.0 or new er y Netscape 7.0 or new er
Firefox 2.0 or new er y Safari 1.1 or new er

** Linux testing included Ubuntu, SUSE and Knoppix
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Notes on Installation and Feature Access 
Please keep the following information in mind when installing and using GoToMyPC: 

 Because of various operating system restrictions, GoToMyPC requires the service to be 
installed on the host PC with administrator rights enabled. Please see your administrator 
for assistance. 

 Because of various operating system restrictions and hardware requirements, some 
features of GoToMyPC may not function on some computers. Please see the Feature 
Requirements section for details. For Server 2003 as a host PC, the www.gotomypc.com 
Web site must first be added as a trusted site. 

 If you are GoToMyPC Corporate or Pro user, your administrator has the ability to restrict 
access to features and/or to require the use of some features. If you have questions 
about your feature-access rights, please see your administrator for assistance. 

Versions of GoToMyPC 
There are three versions of GoToMyPC.  

 GoToMyPC — Secure remote access for individual users  

 GoToMyPC Pro — Secure remote access for teams and small companies  

 GoToMyPC Corporate — Secure remote access for small and medium-sized businesses
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Useful GoToMyPC Terms 
Access Code - The access code is the unique password that users set up for each host PC. It 

must contain at least eight characters and include both letters and numbers. Users will 
enter their access codes every time they access their host PCs remotely. 

Account Password - The account password is used to log in to the GoToMyPC Web site. It 
must be at least eight characters and contain both letters and numbers. 

Client Computer - The client computer is the computer used to access the host PC. It can 
be any Internet-connected computer with a Windows® or Java™-enabled browser, 
located anywhere in the world (airport kiosk, Internet cafe, hotel, library, etc.). 

Computer Nickname - The computer nickname is the name assigned to a host PC during 
installation of the GoToMyPC software. Nicknames help identify different computers set 
up for remote access. 

Host PC - The host PC is the computer you will want to access from a remote location. You 
will install the GoToMyPC software on the host PC. The host PC is a unique and specific 
computer. 

Host PC image - The host PC image is the picture of the host PC desktop that appears in the 
Viewer window.  

One-Time Passwords – One-Time Passwords offer an additional level of security for users. 
This feature will help defeat keyboard-sniffer or keystroke-logger software. 

RADIUS - RADIUS is a two-factor authentication method based on something you know (a 
password or PIN) and something you have (an authenticator), providing a more robust 
level of user authentication. RADIUS is available on GoToMyPC Corporate.  

Session – A session refers to the time you are remotely connected to your host PC.  

System tray icon – The system tray icon represents the status of the GoToMyPC service 
and is used to access GoToMyPC preference and setting options. To access system 
preferences, right click the system tray icon and select Preferences. 

Status state representations 

Icon Status 

 GoToMyPC host PC is running and ready for use 

 GoToMyPC host PC requires authorization before use may begin 

 GoToMyPC host PC is running but connection is interrupted 

 GoToMyPC host PC is being accessed in a session 

 GoToMyPC host PC has screen-blanking enabled while in a session 

 

Viewer - The Viewer is the window displayed on the client computer in which the host PC’s 
desktop will appear. The Viewer window has its own title and menus. 

Windows Name – The Windows name can be used along with the computer nickname to 
identify your computers.  
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Features 

 

Automatic Setup: Plug-in automatically launches, installs and configures itself. No 
restart required. Even novice users can be ready to go in minutes. 

 

Universal Viewer: When you connect to your PC, the Viewer window launches 
automatically, allowing you to view and control your PC from another Windows, 
Windows CE, Mac, Linux, Unix or Solaris computer. No pre-loaded software required. 
Access your PC from any Web browser on any operating system at any time. Even 
work on your office Windows PC from your Mac at home. 

 

PocketView™ Wireless Access: Securely access your PC from your wireless Pocket 
PC device running Windows Mobile 2003/2003SE or later from your device running 
Windows CE 4.0 or later. Provides ultimate mobility. 

 

Drag-and-Drop File Transfer: Easily transfer files by dragging and dropping folders 
and directories between computers. You never again need to email files to yourself or 
copy to a USB flash drive. Get access to your files at any time from anywhere. 

 

File Sync: Synchronize files and folders between your remote PC and any other 
computer with just a click. 

 

Sound: Hear sound on your remote PC with customizable audio settings. Automatic 
muting on your remote PC means sound can only be heard by you. 

 
True Color: View your desktop in brilliant true color. 

 

Performance Tuning: Adjust the speed, sound, color quality and display settings to 
get the performance that best suits your needs. 

 

Multi-Monitor Support: Use GoToMyPC with multiple monitors connected to a single 
PC. 

 

Guest Invite: Invite a second person to temporarily view or share control of your PC. 
Great for tech support, demos or conference viewing of information. 

 

Remote Printing: Print documents to any printer wherever you happen to be – 
there's no need for the application that created the document to be installed on the 
client computer. A hard copy of that forgotten file is only a connection away.  

 

Cut and Paste: Cut, copy and paste text between computers. Simplifies transfer of 
content between desktops. 

 

Encryption and Maximum Security: All data is protected with AES encryption using 
128-bit keys. Dual passwords and end-to-end user authentication. Option to use One-
Time Passwords for maximum security. Most secure Internet connection available in a 
remote-access product. 
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Setting Up GoToMyPC 
Before you can access your PC remotely, you’ll first need to create your account (first time 
users), install the GoToMyPC software and leave the PC accessible. To do this, you will need to 
be at the PC and have the email address and password you used to register. 

Note: To enable all features and functionality, GoToMyPC needs to be installed with Administrator Rights, therefore, 
Corporate and Pro users please contact your administrator for assistance; in some instances, your administrator may 
install GoToMyPC Corporate for you using a remote installation process. 

Create Your Account (first time users) 

 To create your account 

1. Go to your email account and open the email titled Set Up GoToMyPC…. 

2. Click the link in the email to activate your account (first link in email). A new browser 
window opens and prompts you to create your account. 

3. Enter your first and last name, create and confirm your account password, click Submit. 

Set Up a Host PC 

 To set up a host PC for remote access 

Step One - Download the software 

1. Be at the PC that you will want to access remotely; this will be the host PC. 

2. Open a browser window and go to www.gotomypc.com.  

3. Enter your email address and account password and click the Log In button. 

4. First-time users, or users without any PCs set up, click the Install GoToMyPC button. 
Returning users who have more than one license can add additional host PCs from this 
screen. 

5. Click Yes or Grant from the Warning – Security screen to begin downloading the 
GoToMyPC software. 

Step Two - Install the software 

1. Click Next to begin installation. 

2. Select "Yes, I want to restart my computer now" if you intend to use the Fast User 
Switching feature during this session and click Finish.  

Note: If you are using security or firewall software, you must permanently allow GoToMyPC to connect to the 
Internet. See the Using GoToMyPC with Firewalls section for more information. 

Note: If you are a GoToMyPC Corporate user in an environment that requires authentication to access the 
Internet, you will be prompted to enter your authentication during setup. Please contact your administrator for 
further details. 

3. When prompted, enter your email address and account password (these are the same 
that you use to log in to the GoToMyPC Web site) and click OK. 

4. When prompted, enter a computer nickname for the host PC; if needed, select the 
account to which this computer should belong. Give the PC an access code, confirm the 
access code and click OK. 

Note: If you forget your access code or wish to change it, you can quickly create a new one from your host PC. 
Please see the section titled Forgot Host PC Access Code for details. 

Note: For the highest level of security we recommend that your access code be different from your account 
password.  

5. The  icon will appear in the system tray to let you know that the service is running. 

 

https://www.gotomypc.com/
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Leave Your Host PC Accessible 
To be able to access your host PC from a remote client computer, you need to ensure that your 
host PC meets the three following conditions: 

1. The host PC is turned on. 

2. The host PC is connected to the Internet with a live connection. 

3. The GoToMyPC service is running. 

Note: To help ensure security, you may want to lock your PC before you leave it unattended.  

Note: Since GoToMyPC does not require the display monitor on your host PC, you may want to turn it off 
before you leave to conserve energy. You can also set your monitor to automatically power down after a 
specified time in the Display Properties control panel.  

Accessing Your GoToMyPC Host PC 
Once GoToMyPC is set up and running on your host PC, you can access it immediately from 
almost any other client computer with Windows or a Java-enabled browser that is connected to 
the Internet, such as from computers at airport kiosks, Internet cafes, hotels, etc. 

To remotely access your host PC, you’ll need to be at a client computer (any computer other 
than the host PC you just set up) and you will need to know your email address, password and 
access code. 

Access Your Host PC 

 To remotely access your host PC 

1. In your Web browser, type www.gotomypc.com. 

2. Enter your Email address and account Password and click Log In. 

3. If prompted, choose the account you want to access and click Go (only applies if you 
have multiple accounts associated with one email address). 
This will load your My Computers page. 

4. To the right of the Nickname of the PC to which you want to connect, click the Connect 
button. 

5. If prompted, click Run to download the GoToMyPC Viewer. PocketView users will need to 
click the Download link to begin download. 

6. When prompted, enter the Access Code for the host PC and click OK. 

7. The host PC image will appear in the Viewer window. 
You are now connected to your host PC and are ready to start accessing all your files, 
applications and email as if you were sitting at your PC! 

Note:  If a PC's status is Offline, then you will not be able to access that host PC. To access a host PC, you need to leave 
the PC on and connected to the Internet with GoToMyPC running.  

Note: If you are a GoToMyPC Corporate user and your host is a shared PC that is being accessed by another GoToMyPC 
user, "In Session" will appear in the connect box. If you choose to connect to a PC while it is in session, the session in 
progress will be terminated. Keep in mind that the In Session notification will display until the first user terminates the 
connection with the host PC and you refresh your browser. 

  

https://www.gotomypc.com/
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Set Quick Searches 
If your account has more than 10 PCs accessed by the same email address, you can quickly 
locate a favorite host PC with the Quick Searches feature. 

 To set a Quick Search 

1. Select a Quick Searches number that you would like associated with a common search.  

2. In the Search field enter a host PC nickname; or portion of a nickname if you use the * 
wildcard option.  

3. Click the Set Quick Search button to save the search for future use. 

4. The next time you wish to initiate a saved search from the Computer List, simply select 
the Quick Searches number to view your host PC(s).   

Note: This feature is limited to 5 saved searches but a number can be reassigned at anytime. 
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Remotely Unlock Your Host PC  
If your host PC is locked, it may require additional action to unlock it. Your operating system 
determines the unlock method. 

 To unlock 2000, XP Professional or Vista use the Send Ctrl-Alt-Del feature 

1. From the Viewer menu, choose Tools, then Send Ctrl-Alt-Del; or you can click the Send 
Ctrl-Alt-Del button in the upper right-hand corner of the Viewer window.  

 

 

 

 

2. Unlock your PC as you normally would using your network ID and Password. 

 

 To unlock XP Home (or XP Professional with Fast User Switching) 

1. If the screensaver is running, move the mouse to deactivate it. 

2. This displays the logon screen. 

3. Log in to your PC as you normally would. 
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Remotely Lock Your Host PC 
When you are through using your host PC, we recommend that you lock your computer to help 
protect your data. You can set the GoToMyPC Preferences to automatically lock upon disconnect. 
If you wish to do so manually, your operating system will dictate the method you will use to lock 
your PC. 

 To lock Windows 2000, XP Professional and Vista  

1. Complete all activities on your host PC. 

2. From the Viewer menu, choose Tools, then Send Ctrl-Alt-Del. Or click  
the Send Ctrl-Alt-Del button in the upper right-hand corner of the Viewer window.  

This will bring up the Windows Security screen. 

 

 

 

 

3. Click the Lock Computer button. 

Your computer workstation is now locked. 

 To lock Windows XP Home (or XP Professional with Fast User Switching) 

1. Complete all activities on your host PC. 

2. Click the Windows Start button. 

3. Select Log Off. 

4. Select Switch User. 

Your computer workstation is now locked. 

 

End Your GoToMyPC Connection 
Prior to disconnecting from your host PC, you may want to first lock your computer to help 
ensure your security. You can customize GoToMyPC on the Security tab in the Preferences 
window to automatically lock your host PC upon disconnection. 

Note: If you are listening to music from your host PC, be sure to stop the music before disconnecting your session. If 
you do not stop the music on the host PC before disconnection, the music will no longer be muted and could be heard by 
anyone close to your host PC. 

There are three ways to end your GoToMyPC connection. 

 To end your GoToMyPC connection 

 From the Viewer menu, choose File, then Disconnect. 

- Or - 

 In the upper-right corner of the Viewer window, click the  button. 

- Or - 

 Right-click the  system tray icon and select End Session. 
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The GoToMyPC Viewer 

Resize Your Viewer Window 
You can choose to have the Viewer appear as a window on your desktop or as a full-screen 
image. 

 In Window mode: The Viewer appears as a window on your desktop just like any other 
application. The Viewer menu and the Windows controls in the upper-right corner of your 
screen are always available and you can resize the Viewer window just like any other 
application window. 

 In Full Screen mode: The Viewer expands to full screen and the Viewer menu auto-hides 
at the top of the screen. A tab with the same color as your Viewer window is displayed at 
the top of the screen; this tab enables access to the Viewer menu when needed. 

 

 To start Full Screen mode 

 From the Viewer window menu, select View, then Full Screen. 
This expands the Viewer window to Full Screen. 

 

 To end Full Screen mode 

1. Move your mouse over the Viewer window tab at the top of 
the screen. 

The Viewer menu is displayed. 

2. Select View, then Window.  

This cancels the selection of Full Screen mode and returns you to a resizable Viewer 
window. 

 

Resize Your Host PC Image 
You can choose to change the size of the image of your host PC 
desktop within the Viewer. You have the options of choosing to 
adjust your image size to Actual Size, Scale to Fit or Zoom To. 

 Actual Size: Displays the actual image of the host PC 
desktop within the Viewer and may require you to scroll. 

 Scale to Fit: Displays the image of the host PC desktop 
scaled to fit the whole desktop image within the Viewer. 

 Zoom To: Allows you to zoom the image to a setting you 
choose. You can choose from several pre-set options or 
choose a custom option. This selection may require you to 
scroll. 

 To resize your host PC image 

 From the Viewer window menu, select View and then your 
preferred image size: 

 Actual Size 

 Scale to Fit 

 Zoom To 
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Multi-Monitor Support 
GoToMyPC supports multiple monitors connected to a single host PC. You can choose which 
monitor(s) to access while in session.  

 Connecting to a multi-monitor host PC 

1. Log in and connect to your host PC. The default screen is your primary monitor. 

2. To select another monitor, click the arrow button located on either side  
of the viewer window; or click the <Windows> + the left or right arrow key on the 
keyboard.  

Note: For the <Windows> + arrow keys function to work, "Pass Windows keys to host computer" must be 
unchecked on the Preferences > Viewer tab. 

 

3. To view all host PC monitors, hold the <Shift> key while selecting Scale-To-Fit mode 
from the View menu.  

 

 Connecting to a multi-monitor host PC with a multi-monitor client computer 

1. Log in and connect to your host PC. 

2. Change to full screen mode to view both monitors by holding the <Shift> key and 
clicking the maximize/minimize window button on the top right of the Viewer; or hold the 
<Shift> key and select Full Screen from the View menu. 

 

 

 

3. To toggle back to window mode, simply click the maximize/minimize window button in 
the viewer. 

Note: Hardware limitations may prevent host PC screen blanking from working with multiple monitors using a single 
video card.  

Note: Since GoToMyPC does not require the display monitors on your host PC, you may want to turn them off before you 
leave to conserve energy. You can also set your monitors to automatically power down after a specified time in your PC’s 
Display Properties control panel.  
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Minimap 
The Minimap feature displays a scaled down version of your host PC’s monitor(s) and is useful 
when you need to quickly navigate to a different area on the host PC.  

  To navigate with the Minimap window 

1. From the Viewer window, press and hold down the <Ctrl> <Windows> keys on your 
keyboard and then click the mouse button to display the Minimap window.  

2. Click and drag the red box to navigate to another portion of the host PC display. 

3. Release the mouse button to close the Minimap window.  
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Universal Viewer 
The Universal Viewer enables you to view your host PC from any computing device and operating 
system that supports Java, including Mac, Linux and Solaris computers or from Windows 
computers that do not accept downloadable files.  

This feature is particularly useful if you are using an Internet kiosk. To help ensure the greatest 
possible usability, the Universal Viewer has a limited set of features and does not include support 
for Sound, Chat, Clipboard, Remote Printing, File Transfer/Sync or Drag-and-Drop File Transfer 
or Viewer Dimming. 

There is nothing you need to do to enable the Universal Viewer. It will automatically appear 
during the connection process if you are using an operating system other than Windows to 
connect to your host PC, or if you are using a Windows PC that does not accept downloadable 
files. 

To help ensure your security when using the Universal Viewer, you are logged out of your 
GoToMyPC session any time you navigate to a new Web page, exceed your Viewer inactivity 
time-out period without any keyboard or mouse activity, or upon disconnection.  

 To begin a session with the Universal Viewer 

1. Open a browser window and go to 
www.gotomypc.com.  

2. Enter your email address and account 
password and click the Log In b

3. If promp

utton. 

ted, choose the account you 

ts 

C 

us page, click 

want to access and click Go (only 
applies if you have multiple accoun
associated with one email address). 

4. To the right of the nickname of the P
to which you want to connect, click 
the Connect button. 

5. On the connection stat
the Use the Universal Viewer link. 

6. The Universal Viewer should load in 
about 30 seconds. 

 

  

 

https://www.gotomypc.com/
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Universal Viewer Shortcut 
The Shortcut feature adds a shortcut to the client computer’s browser’s Favorites or Bookmarks 
folder. The Shortcut is convenient for users who frequently use the same client computer to 
access the same host PC (e.g. access a work PC from a home computer). The shortcut saves 
time by directing you to the Enter Access Code window, bypassing the usual browser/password 
login page. 

 To create a shortcut from the Universal Viewer 

1. Begin a session as described above. 

2. From the Universal Viewer window, choose File, then Create Shortcut to "Host PC Name." 

3. Click Yes to authorize creation of a shortcut. 

4. Select a location in your browser’s Favorites folder and click OK. 

Note: If your browser does not support creating bookmarks automatically, a link will be provided that can be pasted into 
a bookmark. Simply create a bookmark from your browser and then right-click the new bookmark and select Properties. 
Replace the existing bookmark link with the provided link.   

 

Resize Your Host PC Image 
You can choose to change the size of the image of your host PC desktop within the Universal 
Viewer. You have the options of choosing to adjust your image size to Actual Size, Scale to Fit or 
Zoom To. 

 Actual Size: Displays the actual image of the host PC desktop within 
the Universal Viewer and may require you to scroll. 

 Scale to Fit: Displays the image of the host PC desktop scaled to fit 
the whole desktop image within the Universal Viewer. 

 Zoom To: Allows you to zoom the image to a setting you choose. 
You can choose from several pre-set options or choose a custom 
option. This selection may require you to scroll. 

  To resize your host PC image 

 From the View menu, select View and then your preferred image 
size: 

 Actual size 

 Scale to fit 

 Zoom to 

 

Lock and Unlock your Host PC with Send Ctrl-Alt-Del 
The Send Ctrl-Alt-Del feature can be used to unlock and lock a host PC. For 
more information please see the sections titled Remotely Unlock Your Host PC 
and Remotely Lock Your Host PC. 
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GoToMyPC PocketView 
 

PocketView™  
GoToMyPC PocketView enables you to securely access your host PC from your compatible 
handheld device. GoToMyPC PocketView includes support for use of a stylus, scrolling, scaling, 
and portrait or landscape orientation. 

To help ensure the greatest possible usability, GoToMyPC PocketView does not include Sound, 
Chat, Remote Printing and File Transfer/Sync. 

There is nothing you need to do to enable GoToMyPC PocketView. It will be automatically 
selected during the connection process if you are using a device with a supported operating 
system to connect to your host PC.  

Note: To use GoToMyPC PocketView, see System Requirements at the beginning of this guide. Please note that 
performance will depend on the speed of the device’s connection to the Internet. 

 

 

Accessing Your Host PC Using PocketView 
When accessing your host PC using a PocketView compatible device, follow the same procedure 
that is outlined for use with a desktop computer.  

 To remotely access your host PC 

1. In your Web browser, enter www.gotomypc.com. 

2. Enter your Email address and account Password and click Log In. 

3. PocketView users will need to click the Download link to begin the download. Select the 
checkbox to open the file after download. Overwrite the file if it already exists. Click Yes. 

4. When prompted, enter the host PC's access code and click OK. 

5. The host PC image will appear in the PocketView window. 

6. You are now connected to your host PC and are ready to start accessing all your files, 
applications and email as if you were sitting at your PC! 

 

  

  

https://www.gotomypc.com/
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The PocketView Toolbar and Menu 
The toolbar appears at the top of the handheld device and enables you to quickly access 
common PocketView features. 

 Show menu 

Minimize 

Right-click mode 

Hover mode 

On-screen keyboard 
(tap and hold to 
choose the input 

 

 Show & hide 

 

 Move toolbar Jump-navigate 

  

 

 

The PocketView Menu 
To display the menu, tap the Menu option on the PocketView toolbar. 

 

 

 To adjust host PC image size  

 From the View menu, use the Actual Size, Scale to Fit 
or Zoom To settings 

 

 To adjust host PC image orientation  

 From the View menu, use the No Rotation, Rotate Left 
or Rotate Right settings 

 

 

 

 To access PocketView tools 

 Use the Tools menu to access Send Ctrl-Alt-Del, 
Preferences and PocketView Preferences  
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The PocketView Preferences Dialog 
In addition to the standard GoToMyPC Preferences, PocketView has some per-device settings in 
its PocketView Preferences dialog.  These settings always take precedence over any settings in 
the general GoToMyPC Preferences. 

 Initial size  

 The initial size may be set to Actual Size or Scale 
to Fit or it can start in Jump-Navigate mode in 
which the first tap will zoom to that point in Actual 
Size. 

 

 Initial rotation  

 The initial rotation may be set to No Rotation, 
Rotate Left or Rotate Right. 

 

 Force 256 Colors (requires reconnect) 

 Overrides host PC Color Quality preference set for 
True Color for improved performance. 

 

 Large toolbar  

 Increases the size of the toolbar 

 

 Auto-hide toolbar  

 Hides the toolbar after each action 
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Using PocketView 

 To quickly scroll to another area on your desktop 

1. Tap the Jump-Navigation button on the toolbar to temporarily put the Viewer into fit-
to-screen mode so you can easily see your entire desktop. 

2. Click the part of the screen where you wish to scroll to and you will be returned to your 
previous zoom level, but centered at the location where you clicked. 

 To scroll host PC image 

 Tap and hold the stylus on the edge of the screen to scroll in that direction. Scrolling will 
stop when the stylus is released. When dragging a selection on the host PC, if you drag 
the stylus to the edge of the screen, PocketView will automatically begin scrolling so that 
you can select non-visible areas of the host screen. 

 To right-click 

1. Tap the right-click mode button and the next tap will be a right-click. 

2. Or you can use the tap-and-hold gesture to perform a right-click (not all devices support 
this). 

 To move the cursor without left-clicking 

 Tap the hover mode button and the next tap will only move the cursor. 

 To change the soft input panel 

 Tap, hold and release the on-screen keyboard button to choose an input panel. 

 To create a shortcut to your host PC 

 Choose File from the PocketView menu, then Create 
Shortcut (not all devices support this).  The shortcut 
will be added to your Programs folder. 

 To disconnect a PocketView session 

 Choose File from the PocketView menu, then 
Disconnect. 

 To restore PocketView (Pocket PC and Windows Mobile devices only) 

 To restore PocketView after minimizing it, choose Start, then Programs and then 
GoToMyPC PocketView. 

Note: For more information about GoToMyPC features, refer to the corresponding sections of the GoToMyPC User Guide. 
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PocketView Usage Recommendations 
Choose a device that is appropriate for you: 

1. A Pocket PC, Windows Mobile, or Windows CE device with WiFi provides the fastest 
access. 

2. A Pocket PC Phone Edition or Windows Mobile Phone Edition device provides access over 
the largest geographical area. 

3. An external or built-in keyboard is recommended if you enter text often. 

4. A Windows Mobile device with a high resolution (VGA) screen is recommended for easiest 
viewing. 

Optimize your PocketView experience: 

1. Right-click the GoToMyPC icon on your host computer and select preferences. Under the 
host tab, turn on the following option: 

 Automatically adjust the host computer’s screen area 

2. From the View menu in PocketView: 

 Set the Zoom to 75%  

 Select Rotate Left or Rotate Right 

3. From the File menu in PocketView: 

 Create a shortcut to your host PC 
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Using GoToMyPC Features 
GoToMyPC is easy to use and comes with a complete set of features to help you get the most out 
of remotely accessing your PC. Outlined below are several of the main features you’ll want to 
try. Most of the features are accessible through the Viewer; other features are accessible from 

the  system tray icon, which is usually located in the lower-right corner of your screen near 
the clock. Some features are incompatible with some operating systems. Please see the section 
titled Feature Requirements at the beginning of this document for more information. 

Note: If you are a GoToMyPC Corporate user, your ability to access features may be disabled by your administrator. If 
you are unable to access a feature, please contact your administrator for further details. 

 

Remote Printing 
The Remote Printing feature enables you to print documents that are on your host PC to your 
local client computer printer. From your client computer, you have the ability to print documents 
from a host application that may not be installed on the client computer.  

There are two ways to set up a remote printer:  

 The GoToMyPC Printer (recommended) is a quick and effective method of printing files to 
your client computer’s default printer. Simply select the GoToMyPC Printer from the 
Printer drop-down menu and print as you normally would. Please see the section titled 
GoToMyPC Printer for details. 

 Printing with the GoToMyPC Printer is recommended for most jobs but there may be 
situations (e.g., printing checks or other cases where precision is required) where you 
will want to manually enable a specific printer. This process requires that you first set up 
the client computer’s printer type on the host PC. Please see the section titled Manually 
Enable a Printer for details.  

Note: To simplify the remote-printer setup, we recommend that you configure a printer while connected to 
your host PC from a client computer. 
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GoToMyPC Printer 
When you connect to your host PC, the GoToMyPC Printer feature automatically detects the 
printers available to your client computer. By selecting the GoToMyPC Printer from the Print 
window, you are directing the print job to your client computer’s default printer. 

 To print from the client computer 

1. Open your file and select Print from your application’s File menu. 

2. Verify that the GoToMyPC Printer is selected in the Printer drop-down menu. 

3. Click OK to print to your client computer’s default printer.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 To change the local printer that the GoToMyPC Printer will to print to 

1. From the Viewer window menu, select File, then Select GoToMyPC Printer.  

2. Select the local printer that you want the GoToMyPC Printer to print to.  

3. Return to the client application and print the document by selecting the GoToMyPC 
Printer. 
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Manually Enable a Printer  
If you wish to manually enable a printer and bypass the GoToMyPC Printer, you will be required 
to first set up the client computer’s printer type on the host PC. 

Some printers require a host PC reboot upon setup. This requires the GoToMyPC startup 

preference to be set to start automatically: Right-click the  icon in the system tray of your 
host PC and select Preferences, then Host. Under Start GoToMyPC, check "Automatically" and 
select "After startup." 

Note: The add printer wizard will not be able to detect the type of printer if you attempt to install the printer from the 
system tray icon while you are not in session. The process of installing Remote Printing will vary depending upon 
operating system and access to printer drivers. If you do not have the necessary printer driver on your host PC, you may 
need to download the driver from the manufacturer’s Web site before you can complete the installation of a remote 
printer.  

 To manually install a printer to the client computer while remotely connected 

1. From the Viewer window, right-click the  icon in the system tray and select 
Preferences.  

2. On the Preferences menu, select the Printing tab. 

3. Click the Add Printer button. 

4. On the Select a Printer to Set Up screen, the drop-down menu will automatically select 
the default printer (from your Printers folder) installed on your local client computer. If 
you wish to select another printer, click the drop-down menu and choose the printer you 
want to set up. 

5. Click OK. 

6. The Add Printer Wizard screen opens. Notice the GoToMyPC Printer Setup Instructions 
Tips window attached to the left of the Add Printer Wizard screen. Please pay particularly 
attention to this menu during the setup process; it will provide assistance in setting up a 
GoToMyPC printer. Click Next. 

7. On the Local or Network Printer screen, select Local printer. Make sure that Plug and Play 
auto-detection is NOT selected. Click Next. 

8. On the Select the Printer Port screen, scroll down and select the GoToPort. Click Next. 

9. On the Install Printer Software screen, select the manufacturer and model of your 
printer. Click Next. 

Note: Start by selecting the manufacturer and then select the printer model that is closest to the model you 
have. If you cannot find a match, you may need to download the driver from the manufacturer’s Web site. 
Once you have downloaded the driver (be sure it is the correct driver for your host PC operating system), click 
the Have Disk button, browse to where you downloaded the driver, select the driver and click OK. 

10. On the Name your printer screen, enter the name for this printer. We recommend that 
you keep the "GoToMyPC" preface to the printer name to help you identify the printer in 
the future. Select No if asked to set this printer as the default printer. Click Next. 

11. On the Printer Sharing screen, select Do not share this printer. Click Next. 
12. On the Print Test screen, select Yes if you are remotely connected; select No if not. Click 

Next. 
13. Click Finish. 

Note: If your host PC operating system is Windows 2000, XP or Vista and you wish to manually enable a printer, please 
ensure that you have administrator rights when you upgrade/install GoToMyPC. 
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File Transfer 
File Transfer enables you to quickly and easily transfer files between your host PC and client 
computer. You can use the File Transfer feature or you can drag and drop files simply by clicking 
on a file and dragging it between computers. 

 To transfer files 

1. From the Viewer menu, choose 
Tools, then Transfer or Sync 
Files. Or you can click the File 
Transfer button in the upper 
right-hand corner of the Viewer 
window. 
 
The File Transfer and Sync 
window opens. The host PC files 
are in the left pane, the client 
computer files on the right. 

 

2. For the computer you wish to 
transfer files to, browse to and 
select the folder to store the 
transferred files. 

3. For the computer you wish to 
transfer files from, browse to 
and select the file or folder you wish to transfer and either click the Transfer button or 
drag-and-drop the desired files to the destination computer. 

4. Click Done from the File Transfer status window when complete.  

 

 To drag and drop files 

 To drag and drop files directly between your host and client simply drag a file or folder 
from the Viewer window to your local computer (or the other way around) to start 
copying.  

 

 

 

 

Note: If you are having difficulty finding the files to send, or finding the files you sent, it is likely due to the use of a user 
profile, which most often occurs with Windows 2000. To transfer desktop files stored in your profile or to find files you 
transferred to your desktop, you will need to look for the appropriate folder within your user profile. Windows 2000 
users: go to C: Documents and Settings, then Your User Name, then Desktop.  

Note: If you are having difficulty transferring files from Windows Vista, it could be that you are attempting to transfer 
files from a folder that requires privilege elevation. To transfer these files, first transfer them to a folder you have 
permission to write to, and then move them to their final destination using Windows Explorer.   
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File Sync 
The File Sync feature enables you to easily synchronize folder contents between the host PC and 
client computer while in-session. Since File Sync is bi-directional, files are transferred in either 
direction until both sides match. When files with the same name exist on both ends, you have 
the option to copy the newer file, copy the older file or skip the file. 

 

 To synchronize folders 

1. From the Viewer menu, choose Tools, then Transfer or Sync 
Files. Or you can click the File Transfer button in the upper 
right-hand corner of the Viewer window. 

 

 

 

The File Transfer and Sync window opens. The host PC files 
are in the left pane, the client computer files on the right. 

2. Double-click the folder you want to sync on the host PC so 
that the contents are displayed in the left pane. 

3. Next, double-click the corresponding folder you want to sync on the client computer so 
that the contents are displayed in the right pane. 

4. Click the Sync Views button from the File Transfer and Sync window.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. From the Sync Confirmation window, indicate how you prefer GoToMyPC to handle 
different files with the same name.  

6. Click Continue to begin synchronization. 

  



GoToMyPC® User Guide 
 

 

© 2008 Citrix Online, LLC. All rights reserved.  26 

Repeat a Recent File Sync 
Select the Repeat a Recent File Sync shortcut to save the step of navigating to the individual 
folders on your host PC and client computer. This feature displays a selectable list of the last 
three syncs for quick execution. 

 To repeat a recent file sync 

1. From the Viewer menu, choose Tools and then Repeat a Recent File Sync.  

2. Select a folder pair from one of the three most recent file syncs. 

3. Confirm the folder locations and indicate how you prefer GoToMyPC to handle different 
files with the same name.  

4. Click Continue to begin synchronization. 
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Remote Sound 
GoToMyPC now supports one-way sound from your host PC to your client computer. The sound 
settings can be optimized for system sounds or music depending on your sound card, personal 
preferences and the speed of your network connection. Temporary adjustments to your in-
session sound settings can be made directly from the Viewer window. Adjustments to your sound 
settings can be made at any time in the Preferences window or directly from the Sound button 
in the upper right-hand corner of the Viewer window. 

 

 

 To modify your sound preferences 

1. Click the Sound button in the upper right-hand corner of the Viewer window. 

2. Select Sound Settings from the menu. 

3. From the Sound tab modify your sound settings and click OK. 

Sound Features 
 When my session starts: Select 

your preferred sound settings on 
startup. Select the Turn off Sound 
option for optimal system 
performance. If you intend to listen to 
music, select Use High Quality Sound. 

 Sound options: Select your 
preferred audio source or let 
GoToMyPC detect the source 
automatically. If desired, GoToMyPC 
can automatically disable the Sound 
feature if a slow network connection 
is detected. For in-session privacy, 
leave the "Mute speakers on the host 
PC while in session" option selected.  

The Manual option on the Sound Options drop-down list is not recommended for typical use. 
When selected, GoToMyPC records sound from the Windows default recording device without 
changing the active input or volume level. If these inputs are not configured correctly the sound 
may not work or have poor quality. 

Please see the Troubleshooting Sound Issues section for more information on the Sound feature. 

Note: If you are listening to music from your host PC, be sure to stop the music before disconnecting your session. If 
you do not stop the music on the host PC before disconnection, the music will no longer be muted and could be heard by 
anyone close to your host PC.  

Note: For optimal music quality, install the latest approved Windows Media Player on both the host PC and client 
computer.  

Note: The High Quality Sound option is currently not available on Windows Vista. Sound is not available with the 
Universal Viewer or PocketView.  

Note: GoToMyPC software may be used to access materials on a remote computer. It is licensed to you only for access 
to remote computers which you are authorized to access or make use of, and for access to non-copyrighted materials, 
materials in which you own the copyright, or materials you are authorized or legally permitted to access. If you are 
uncertain about your right to access any material you should contact your legal advisor. 
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Session Performance 
While remotely connected to your PC, you can review your session performance and tips for 
improving the performance.  

Note: GoToMyPC will automatically disable Vista’s Aero Glass Windows theme to maintain optimal performance.  

 To view your session performance 

1. In the GoToMyPC Viewer window, click Help in the top menu. 

2. Select Session Performance. 

3. Your session performance will be displayed for the host PC to which you are currently 
connected.  

 

 

 Select to 
view 
performance 
of last 10 
minutes or 
click drop-
down menu 
to view 
performance 
of any of 
previous 10 
sessions. 

 

 

 

 

 

The performance 
graph below 
changes as you 
move your 
cursor over the 
blue bar to 
reflect 
performance of 
your host PC, 
client computer, 
and internet. 

 

 

 Click here to 
view 
performance 
improvement 
suggestions. 

 

Shows time 
delay over the 
last 10 minutes. 
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Guest Invite 
The Guest Invite feature enables you to invite a guest to view the desktop of your host PC while 
you are physically present at your host PC. 

 To invite a guest to your host PC 

1. Right-click the  system tray icon and select  
Invite Guest to PC. 

2. When prompted, type in the email address of the guest you 
want to invite. Or you can select an email from a list of 
recently invited guests by clicking the drop-down menu.  

3. Add to or customize the message that will be sent to your 
guest (optional). 

4. From the drop-down menu, select the time when the invitation 
will expire. 

5. Click Send. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. When prompted, enter the email address and password you use to log in to GoToMyPC. 

7. Click OK. 

8. Your invitation is sent to your guest, who will receive it via email. Click OK to close the 
send notification. 

Note: You must be at your host PC to invite a guest to connect to it. After you send an invitation, you can check the 
time left on the invitation or cancel it by right-clicking the system tray icon and selecting Guest Invited. You can invite 
guests on any operating system and GoToMyPC will provide the appropriate Viewer window. 
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Connect to an Invited Guest 
To accept the invitation, your guest will need to click the activation link included in the invitation 
email. If your guest accepts within the time you allotted, you receive a Guest Arrived notice. 

 To connect with the guest on your host PC 

1. In the Guest Arrived window, select the 
corresponding check box to give your guest 
view-only access or full remote-control 
access to your computer. 

2. Uncheck the Sound box if you do not want 
your guest to hear the sound on your PC.  

3.  Click OK. 

A chat box will appear on your desktop and 
your guest will be able to view your desktop 
with a Viewer window on his or her desktop. 

 

 

 

 

 

Change Guest Access 
You may change your guest’s access or disconnect the session at any time. 

 To modify guest access from your host PC 

1. Right-click the   system tray icon and select Guest Connected. 

2. Select the desired level of access or disconnect the session. 
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Chat 
Chat is a function that enables you to communicate with a guest you have invited to your 
computer. To communicate with Chat, simply enter your text into the text entry field and click 
Send or press the <Enter> key on your keyboard. The chat dialog is automatically displayed 
once your guest is connected. 

 To open a Chat dialog 

 From the Viewer window menu, select Tools, then Chat. 
The chat box will appear on both the host PC and client computer. 

 

 To end Chat 

 From both the host and client chat box, simply close the 
box by clicking  in the upper-right corner of the chat 
dialog.  
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Drawing Tools in Guest Session 
The Drawing Tools feature enables you and your guest to use a mouse to draw or highlight on 
the screen for greater communication.  

Note: The Drawing Tools feature is only accessible while connected to a guest.  

 To use a drawing tool 

1. To access the drawings tools from the guest’s Viewer window, choose Tools, then 
Drawing Tools. Or the guest can click the Drawing Tools button in the upper right-hand 
corner of the Viewer window. 

 

 

 

To access the drawing tools from the host PC, right-click the  icon in the system tray 
and select Drawing Tools. 

2. Select the desired tool and click and drag to draw on the screen. 

 

 

 

 

 

 

 

 

 

 

 To erase drawings 

 With one of the drawing tools enabled, right-click the screen and select  
Erase All Drawings.  

This will erase your drawings but keep you in the drawing mode. 

 

 To exit the drawing mode 

 Press the <Escape> key or right-click the screen and select Mouse Pointer  
from the Drawing Tools menu to exit the drawing mode. 
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Cut/Copy and Paste 
The cut/copy and paste feature enables you to cut/copy and paste text between the host PC and 
client computer. 

 To cut/copy and paste text 

1. Select the text you want to cut or copy by left-clicking you mouse and dragging the 
cursor over the text. 

2. Right-click your mouse on the selected text and choose Cut or Copy. 

3. Place your mouse in the location where you want to paste the text and left-click your 
mouse. 

4. Right-click your mouse and select Paste. 

Note: The cut/copy and paste feature has a text-only maximum of 32kb of data.  
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Desktop Shortcut 
The Desktop Shortcut feature adds a shortcut to the client computer desktop that links directly 
to your host PC to enable fast and easy access to the PC. Desktop Shortcut is convenient for 
users who frequently use the same client computer to access the same host PC (e.g. access a 
work PC from a home computer). The shortcut saves time by directing you to the Enter Access 
Code window, bypassing the usual browser/password login page. 

 To create a desktop shortcut 

1. Log in and remotely connect to your host PC from the 
client computer on which you want to create the 
desktop shortcut. 

2. From the client computer Viewer window, choose File, 
then Create Shortcut to "Host PC Name". 

3. Click Yes to authorize creation of a desktop shortcut. 

4. Enter your account password and click Continue. 

5. Click OK. 

A desktop shortcut will be created on your client computer desktop. 

Note: The first time you use a shortcut from a client computer, you will be required to authenticate your account by 
entering your email address and password. If this first-time log in is successful, subsequent uses of Desktop Shortcut on 
the client computer will not require authentication. The Create Shortcut menu item on the File menu will not be visible 
when a guest is connected to your PC during a Guest Invite session so that guests cannot create shortcuts from their 
computers to yours. You can revoke all shortcuts associated with your host PC by clicking the Edit link on the My 
Computers page. 

 To access your host PC using a desktop shortcut 

1. From the desktop of the client computer, double-click the GoToMyPC 
Desktop Shortcut icon. 

2. When prompted, enter the access code for your host PC. 

The GoToMyPC connection will begin. 

 To revoke all desktop shortcuts to your host PC 

1. Log in to your GoToMyPC My Computers page. 

2. On the My Computers page, click Edit next to the name of the PC for which you wish to 
revoke all desktop shortcuts. 

3. Next click the Revoke button; this will invalidate all shortcuts to your host PC. 

Note: If you are a GoToMyPC Corporate account user, your ability to access features may be disabled by your GoToMyPC 
account administrator. If you are unable to access a feature, please contact your account administrator for further 
details. 

Reconnect  

 

GoToMyPC warns you if a session is about to be 
disconnected due to inactivity. If prompted, simply click 
Keep Active to keep the session active; otherwise, click 
the Disconnect Now button to end the session. 

If your session is timed-out, you are given an option to 
begin a new session by clicking Reconnect from the 
Inactivity window. If you used the Shortcut feature to 
begin the session, you are quickly directed to the Enter Access Code window.  
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Remember Me 
The Remember Me feature enables you to set a cookie in your browser that will automatically log 
you in to a specific GoToMyPC account - without the need for you to enter your email and 
password – simply by returning to the GoToMyPC Web site. 

 To enable Remember Me 

1. From the client computer on which you want to activate the Remember Me feature - log 
in to your GoToMyPC account. 

2. Click the My Account link in the left navigation bar. 

3. Select the check box for Remember Me. 

4. Enter your current password to make changes. 

5. Click Save Changes. 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Use of the Remember Me feature requires that cookies be enabled for your browser (please see your browser’s 
Help for directions on how to enable cookies). To use the Remember Me feature, you must close your browser by clicking 

the  button in the upper-right corner of the browser window, or by choosing File then selecting Close from the menu. 
The Remember Me feature will NOT work if you click the Log Out link in the left navigation bar. 

 To disable Remember Me 

1. From the client computer on which you want to activate the Remember Me feature, log 
in to your GoToMyPC account. 

2. Click the My Account link in the left navigation bar. 

3. Uncheck the Remember Me check box to clear. 

4. Enter your current password to make changes. 

5. Click Save Changes. 
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In-Session Reboot (GoToMyPC Corporate only) 

The In-Session Reboot feature enables you to remotely reboot your host PC and log back in with 
your Windows login credentials. This is an exclusive feature to accounts that have the Shared 
Access feature enabled. Since the In-Session Reboot feature is not a default setting, it must first 
be enabled by your administrator at the user or group level in the GoToMyPC Administration 
Center.  
 
 
 
 
 
 
 
 
 
 

View Access Activity Report 
The Access Activity Report enables you to view your account’s connections for a selected day. 
The report will tell you the source of the connection, the time it occurred, the client IP, the type 
of access and the duration of the connection. 

 To view the Access Activity Report 

1. Log in to your GoToMyPC account at www.gotomypc.com. 

2. Click the My Computers link in the left menu. 

3. Click the Access Activity link in the left menu.  

4. Select the desired date for the access activity. 

5. Click the View Access Activity button. 
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One-Time Passwords 
The use of One-Time Passwords (OTPs) offers an additional level of security that can protect you 
while you are using public terminals that may have keyboard loggers or other keystroke-capture 
hardware or software. Our One-Time Passwords system ensures that a discovered password is 
useless to the person who discovers it. 

One-Time Passwords are composed of six words, and each six-word combination provides one-
time access to a host PC. Password lists are numbered in reverse order from highest to lowest 
and end in zero. 

The use of One-Time Passwords enables you to generate a list of One-Time Passwords that you 
will be prompted to enter after you enter your access code each time you access your host PC. 

Note: Your administrator may require that you use One-Time Passwords. The One-Time Passwords feature cannot be 
used in conjunction with the Share Access feature. 

  To enable One-Time Passwords 

1. While physically present at the host PC you want to enable for One-Time Passwords, 

right-click the  system tray icon and choose Preferences. 

2. Click the Authentication tab, then click the Enable OTPs button. 

3. On the Generate One-Time Passwords dialog box, select the number of One-Time 
Passwords to generate (min. of 10, max. of 99) and click OK. 

4. On the Enter Access Code box, enter the access code for the host PC and click OK. 

5. On the Print One-Time Passwords List dialog box, select the font size to print and click 
the Print button. 

6. Verify your list of One-Time 
Passwords has printed and 
click Close. 

7. On the GoToMyPC 
Preferences dialog box, 
click OK. 

You have now enabled use 
of One-Time Passwords on 
your host PC and you will be 
prompted to enter an OTP 
next time you access your 
host PC from a client 
computer. 
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 To access your host PC using One-Time Passwords 

1. Point your Web browser to www.gotomypc.com. 

2. Enter your email address and account password and click Log In. 

3. If prompted, choose the account you want to access and click Go (only applies if you 
have multiple accounts associated with one email address). 

This will load your My Computers page. 

4. To the right of the computer Nickname, click the Connect button. 

5. When prompted, click Yes or Grant to download the GoToMyPC Viewer. 

6. When prompted, enter the host PC's access code and click OK. 

7. When prompted, enter the requested six-word One-Time Passwords and click OK. 

8. The host PC image will appear in the Viewer window. 

You are now connected to your host PC and are ready to begin accessing all your files, 
applications and email as if you were sitting at your PC! 

 To generate a new list of One-Time Passwords 

1. While physically present at, or connected to, the host PC for which you want to generate 

a new list of One-Time Passwords, right-click the  system tray icon and choose 
Generate One-Time Passwords.  

2. On the Generate One-Time Passwords dialog box, select the number of One-Time 
Passwords to generate (min. of 10, max. of 99) and click OK.  

3. On the Enter Access Code dialog box, enter the access code for the host PC and click OK.  

4. On the Print One-Time Passwords List dialog box, select the font size to print and click 
the Print button. 

5. Verify that your list of One-Time Passwords has been printed and click Close. 

Note: You can generate a new list of One-Time Passwords at any time while still have OTPs available. Should you use all 
your OTPs before generating a new list, you will have to return to your host PC to generate a new list or to disable One-
Time Passwords. 

 To disable One-Time Passwords 

1. While at the host PC for which you want to disable One-Time Passwords, right-click the 

 system tray icon and choose Preferences. 

2. Click the Authentication tab.  

3. Click the Disable OTPs button. 

4. Click Yes on the warning dialog box that you want to disable One-Time Passwords.  

5. On the Change Access Code dialog box: 

 Enter your old access code. 

 Enter your new access code. 

 Confirm your new access code. 

 Click OK. 

6. On the GoToMyPC Preferences dialog box click OK. 

Note: To help protect your security, you will be required to change your access code for your host PC anytime you 
disable the use of One-Time Passwords. 
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Host Authorization (GoToMyPC Corporate only) 
If you are a GoToMyPC Corporate user, your administrator may require you to request 
authorization for your host PC before you can set up or access that host PC. Authorization 
requires that you send your host PC’s MAC address and C: Drive serial number to your 
administrator. 

 To authorize your host PC for a new host PC installation 

 Upon completion of the GoToMyPC Corporate installation, you will be presented with an 
installation confirmation window that will also provide you with the MAC address and C: 
Drive serial number; copy the information and email it to your administrator. Your 
administrator will authorize your host PC and should notify you when authorization is 
complete. 

 

 To authorize your host PC for an existing host PC 

1. While physically present at the host PC you want to authorize, right-click the  icon in 
the system tray and choose Preferences. 

2. Click the Host tab. 

3. Click the Authorization ID button. 

4. On the Host Authorization Identification dialog box, copy the MAC address and C: Drive 
serial number and email it to your administrator. 

5. Your administrator will authorize your host PC and should notify you when authorization 
is complete. 

 

Client Authorization (GoToMyPC Corporate only) 
If you are a GoToMyPC Corporate user, your administrator may require you to request 
authorization for your client computer before you can use it to access your host PC. 
Authorization requires you to send your client computer’s MAC address and C: Drive serial 
number to your administrator. 

 To authorize a client computer 

 While at the client computer you want to authorize, access your GoToMyPC Corporate 
account and begin a connection to your host PC. Once the download process is 
completed and the Viewer window appears you will be notified that the client computer 
requires authorization. The notification dialog box will contain the client computer’s MAC 
address and C: Drive serial number; copy the MAC address and C: Drive serial number 
and email it to your administrator. Your administrator will authorize your client computer 
and should notify you when authorization is complete. 
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RADIUS Integration (GoToMyPC Corporate only) 
If you are a GoToMyPC Corporate user, your administrator may configure your GoToMyPC 
account to integrate with RADIUS. 

RADIUS is a two-factor authentication method based on something you know (a password or 
PIN) and something you have (an authenticator), providing a more robust level of user 
authentication. 

Use of RADIUS will prompt you to enter your RADIUS credential (PIN and tokencode) after your 
access code each time you access the host PC. 

Note: RADIUS Integration is only available if your administrator has required the use of RADIUS. This option will not 
appear to users who are not configured to use RADIUS. 

 

 To configure RADIUS on your host PC 

1. While at the host PC you want 
to enable for RADIUS, right-

click the  system tray icon 
and choose Preferences.  

2. Click the Authentication tab. 

3. Click the Configure RADIUS 
button. 

4. On the Configure RADIUS 
dialog window, enter the 
RADIUS server name to the list 
by entering its hostname or IP 
address, then click Add. 

5. Enter your RADIUS user name 
(name of the user in the 
RADIUS database). 

6. Enter the RADIUS encryption key (provided by the system administrator). 

7. Click the Test Configuration button. 

8. When complete with configuration and testing, click OK to close the Configure RADIUS 
dialog box. 

9. Click OK to close the GoToMyPC Preferences dialog box. 

Note: Before you can configure your host PC with RADIUS, your administrator must enable you to view the option to 
configure RADIUS, which is located on your GoToMyPC Preferences menu. Your administrator may choose to configure 
your host PC for you. 

  

 



GoToMyPC® User Guide 
 

 

© 2008 Citrix Online, LLC. All rights reserved.  41 

 

 To connect to your host PC with RADIUS 

1. Point your Web browser to www.gotomypc.com. 

2. Enter your email address and account password and click Log In. 

3. If prompted, choose the account you want to access and click Go (only applies if you 
have multiple accounts associated with one email ID). This will load your My Computers 
page. 

4. To the right of the Nickname of the PC to which you want to connect, click the Connect 
button. 

5. When prompted, click Yes or Grant to download the GoToMyPC Viewer. 

6. When prompted, enter the host PC's Access Code and your RADIUS credential (your PIN 
and tokencode from token) and click OK. 

7. The host PC image will appear in the Viewer window. 

You are now connected to your host PC and ready to start accessing all your files, 
applications and email as if you were sitting at that computer! 

 

 To disable RADIUS 

1. While physically present at your host PC, right-click the   system tray icon and choose 
Preferences.  

2. Click the Authentication tab.  

3. Click the Disable RADIUS button. 

4. On the Change Access Code dialog box: 

 Enter your old access code. 

 Enter your new access code. 

 Confirm your new access code. 

 Click OK. 

5. On the GoToMyPC Preferences dialog box click OK. 

Note: You cannot disable the use of RADIUS unless your administrator has turned off the requirement to use RADIUS. 
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Setting Preferences 
GoToMyPC has several options that can be configured to suit your personal needs. 

 To set preferences 

1. Right-click the  icon in the system tray of your host PC 
and select Preferences. 

- Or - 

Access Preferences from the Viewer Tools menu. 

2. Select the appropriate tab for the set of preferences you 
want to customize. 

3. Select your preferences. 

4. Click OK. 

Note: Your Preferences options may be affected by the type of operating system you are running and the type of rights 
your user account allows. Grayed-out options are not available for selection with your operating system or for the rights 
assigned to your computer profile. 

 

Host Preferences 
The host preferences option enables you to configure settings for the host PC. 

1. Choose how to start GoToMyPC: 

 Run GoToMyPC automatically: Start GoToMyPC when you start your computer 
(default) or when you log in (optional for users with administrative rights). To ensure 
maximum availability of the host PC, we recommend you choose to start GoToMyPC 
automatically after startup. 

 Run GoToMyPC manually: Uncheck "Automatically" and GoToMyPC will start only 
when you launch the application from your Programs menu. 

2. Choose desktop options while connected: 

 Automatically adjust host screen area for best full-screen viewing: If possible, it will 
resize the host PC screen resolution to best match the client computer resolution. 

 Disable sleep mode on host PC: Disables sleep mode so host PC remains accessible. 

 Show host PC cursor: Enables the viewing of both host and client cursors. 

3. Desktop Notifications (Personal and Pro only): Delivers access to complimentary Citrix 
Online upgrades, information, news and discounts that you may be eligible for.  

4. Authorization ID (GoToMyPC Corporate only): Provides host PC MAC Address and C: 
Drive Serial Number for use when host PC authorization is required by administrators. 

Note: MAC addresses cannot be used for authorization when either the host PC or client computer connects to 
the Internet via a dial-up modem because, unlike with Ethernet and Wireless network adaptors, dial-up 
modems don't have MAC addresses. In these cases, using the C: drive serial number of the computer is the 
option if host or client Authorization is desired. 
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Viewer Preferences 
The Viewer preferences option enables you to configure settings for the Viewer window. 

1. Screen size: 

 Start host PC desktop in: Choose to start the host PC desktop in either full-screen 
mode or in Window (in Viewer) mode. 

 Show host screen: Choose to view the host desktop image in actual size (may require 
scrolling in the Viewer) or scale-to-fit. 

2. Viewer options: 

 Show update regions: Provides an outline around the area of the screen that is 
redrawn when your Viewer refreshes its image. 

 Dim Viewer when inactive: Dims your Viewer window whenever you switch to your 
local client computer window. 

 Copy/paste between computers: Enables cut, copy and paste text between host PC 
and client computer. 

 Pass Windows keys to host PC: Enables special key combinations such as Alt-Tab and 
Alt-Shift-tab, Windows key and Print Screen to be passed to the host PC. 

Note: This feature is not available from the Universal Viewer.  

 Select Viewer Color: Enables you to change the color of your Viewer window. 

 

Performance Preferences 
The Performance preferences option enables you to adjust the speed, color quality and display 
settings to get the performance that best suits your needs.  

1. Color Quality: 

 True Color: Select True Color for better appearance. 

 256 Colors: Select 256 Colors for better speed. 

2. Performance: 

 Better Speed: Move the slider to the left to disable settings that affect performance. 
The disabled settings will be displayed in the bottom pane. 

 Better Appearance: Move the slider to the right to enable settings that affect 
appearance. 

3. Performance History: 

 Click the Performance History link to review current and historical session 
performance and improvement tips. 
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Sound Preferences 
GoToMyPC supports one-way sound from your host PC to your client computer. The sound 
settings can be optimized for system sounds or music depending on your sound card, personal 
preferences and the speed of your network connection. 

1. When my session starts:  

 Turn off sound: Select this option to optimize performance. 

 Use Low Quality Sound: Enables lower quality sound for better performance. 

 Use High Quality Sound: Select this option if you intend to listen to music from your host 
PC. 

Note: The High Quality Sound option is not available on Windows Vista. 

2. Sound options:  

 GoToMyPC will play sound from: Select your preferred audio source or let GoToMyPC 
detect the source automatically. 

 Automatically disable sound if network connection is slow: This option automatically 
disables the Sound feature if a slow network connection is detected. If the network 
performance improves, you will need to manually enable the Sound feature.  

 Mute speakers on the host PC while in-session: Leave this option checked for in-session 
privacy.  

Note: If you are listening to music from your host PC, be sure to stop the music before disconnecting your session. If 
you do not stop the music on the host PC before disconnection, the music will no longer be muted and could be heard by 
anyone close to your host PC.  
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Security Preferences 
The security preferences option enables you to configure additional security settings. 

Security Features: 

 Lock Upon Disconnection: Automatically lock the host PC when you end your GoToMyPC 
connection. 

 Screen Blanking: Enables you to blank out the screen of the unattended host PC while 
you are remotely connected. 

Note: Hardware limitations may prevent host PC screen blanking from working with multiple monitors using a 
single video card.  

 Keyboard/Mouse Locking: This security feature prevents others from using your host 
mouse or keyboard while you are remotely connected. 

 Viewer Security Time-Out: Enables you to set the amount of time in minutes for the 
Viewer window to time-out if no mouse or keyboard activity is detected. Default for this 
setting is 15 minutes. 

Note: To maximize your security, we recommend that you enable all security settings. 

 

Authentication Preferences 
The authentication preferences option enables you to configure settings for the host PC access 
code, use of One-Time Passwords (OTPs) and configuring RADIUS integration (GoToMyPC 
Corporate users only.) If the Shared Access feature is turned on by your administrator, you can 
view information on your host PC’s accessibility. 

1. Access Code: All users are required to have an access code for each host PC. The access 
code is only stored on the host PC and is never transmitted across the Internet. 

 Change Access Code: Enables you to change your access code by entering your old 
access code, entering a new access code and confirming the new access code.  

 Forgot the Access Code: Click the Forgot it? link and enter your email address and 
password to reset your access code. You must by physically present at the computer 
to reset it. 

2. One-Time Passwords: Provides the ability to enable the use of One-Time Passwords and 
to generate password lists. One-Time Passwords is a secondary authentication method 
that requires you to enter a string of one-use passwords in addition to your access code 
to access your host PC. 

 Enable OTPs: Turns on the requirement to use One-Time Passwords. 

 Generate OTPs: Generates a new list of One-Time Passwords. 

Note: To disable One-Time Passwords, you must be physically present at your host PC and will be required 
to change your access code. The One-Time Passwords feature will not be available to you if your 
administrator has designated your account a Shared Access host. 

 Configure RADIUS: Enables you or your administrator to enter configuration 
information to enable the host PC to communicate with the RADIUS servers. 
Configuration information required is: RADIUS server name, RADIUS user name and 
RADIUS encryption key. 

Note: RADIUS Integration is only available if you have GoToMyPC Corporate and your administrator has 
required the use of RADIUS. This option will not appear to users who are not configured to use RADIUS. 

3. Shared Access: If you are a corporate user and your administrator has designated your 
host PC as a Shared Access host PC, this section displays the PC name and the number 
of users who have access to it.  
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Printing Preferences 
Printing with the GoToMyPC Printer is recommended for most jobs but there may be situations 
(e.g., printing checks or other cases where precision is required) where you will want to 
manually enable a specific printer. The Printing tab enables you to add or delete printers and set 
the default printer you wish to use during a GoToMyPC session.  

Note: To simplify the remote-printer setup, we recommend that you configure a printer while connected to your host PC 
from a client computer. 

 

Connections Preferences 
The Connections tab enables you to test the status of your host PC connection. 

Note: To ensure a valid connection test, we advise that you refrain from testing your connection unless a GoToMyPC 
customer-support representative directs you to perform the connection test. 
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Managing Your PCs 

Add, Reinstall or Remove Host PCs  
You can add, remove and reinstall host PCs at any time, which gives you the flexibility to rotate 
host PCs on your account.  

 To add or reinstall a host PC to your account 

1. Go to the PC you want to add to your account. 

2. Log in to your GoToMyPC My Computers page. 

3. Click the Install GoToMyPC button to install the PC. 

4. Follow the normal process to download GoToMyPC and register a host PC. 

Note: Your ability to add PCs will depend upon the plan you have purchased or, if you are a GoToMyPC 
Corporate account user, the number of computers your administrator has authorized. 

 To remove a host PC from your account 

1. Log in to your GoToMyPC My Computers page. 

2. On the My Computers page, click on the link to edit the PC you wish to remove. 

3. Click Delete to remove the host PC.  

4. To remove the GoToMyPC service from the host PC, please use Add/Remove Programs 
feature on your host PC. 

Note: You may add and remove host PCs as often as you wish. You may also want to consider upgrading your 
account to allow for a greater number of PCs to be permanently available to you. If you are a GoToMyPC 
Corporate user you cannot delete a Shared Access host PC if it is shared with another user. Contact your 
administrator to remove all shared-access users so that you can delete your host PC. 

 

Revoke Desktop Shortcuts 
If you have left a desktop shortcut on one or more client computers, such as a public computer 
at an Internet kiosk, you can revoke the shortcut and it will no longer be valid. 

 To revoke all desktop shortcuts to your host PC  

1. Log in to GoToMyPC and click My Computers. 

2. From the My Computers page, click the link to edit the host PC you wish to revoke all 
desktop shortcuts. 

3. Click the Revoke button to invalidate all shortcuts to your host PC. 
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Move Host PCs between Accounts 
To move a host PC from one account (e.g., individual account) to another account (e.g., 
Corporate account) you will need to uninstall and reinstall the GoToMyPC software for each PC 
you wish to move. Moving a host PC from one account is a two-step process. 

 To move a registered PC to another account 

Step One - Remove GoToMyPC from your host PC and My Computers page. 

1. First, remove the PC from the My Computers page for the account. 

 Log in to your GoToMyPC My Computers page. Click the link to edit the host PC you 
wish to remove and then click the Delete button. 

2. Then, remove the GoToMyPC service from your host PC. 

Go to the host PC from which you want to remove the GoToMyPC service and uninstall 
GoToMyPC from the PC. 

 From the Windows Task bar click Start and select Settings, Control Panel, 
Add/Remove Programs and then select and remove GoToMyPC. 

 

Step Two - Add GoToMyPC to your new host PC and My Computers page. 

1. First, go to your new host PC and download the GoToMyPC software. 

 Log in to your GoToMyPC My Computers page for the specific account and download and 
set up GoToMyPC on that PC. 
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Change Your Host PC Nickname 
You can change your host computer’s nickname at anytime. 

 To change your host PC nickname 

1. Log in to your GoToMyPC My Computers page. 

2. Click on the link to edit the host PC settings. 

3. In the Nickname field, type in the new nickname and click the Rename button. 

The Nickname is changed. 

 

Forgot Host PC Access Code 
You may change the host PC access code at any time. 

 To create a new access code 

1. Go to the host PC whose access code you would like to change. 

2. Make sure that the GoToMyPC service is running (look for  icon in the system tray). 

3. Right-click on the  system tray icon and select Change Access Code. 

4. Click the Forgot it? link. 

5. Enter your email address and account Password. 

6. On the New Access Code dialog box, enter your new access code, confirm the new 
access code and click OK. 

Note: You will need to be physically present at your host PC to create a new access code because you will not 
be able to log in to your host PC without knowing the access code for that computer. 

 

Forgot Account Password 
If you forget your account password, you will have to create a new account password. 

 To create a new account password 

1. Go to www.gotomypc.com and click the Forgot your Password? link below the log in box. 

2. Enter your email address that was used to create your account and click Submit. 

An email will be sent to your email address with a link to create a new account password. 

3. Go to your email and click the link to create a new account password. 
A Web page will generate for you to enter your new account password. 

4. Enter your new account password. 

5. Re-enter your new account password to confirm.  

6. Click OK. 

Note: You will receive an email with instructions for creating a new password. The email will be sent to the email 
address you provided when you created your GoToMyPC account. If the email account is accessible only from the host PC 
you are trying to access, you will need to be physically present at your host PC to view the email. 
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Shared Access (GoToMyPC Corporate only) 
If your company account is enabled with shared access, your administrator may give access 
rights to other users – most often people who manage your PC. For example, your company’s IT 
specialist may use GoToMyPC Corporate to remotely maintain your PC. If your administrator has 
enabled shared access to your PC, you will: 

 Receive an email from GoToMyPC Customer Care notifying you that your administrator 
has enabled shared access on your PC with at least 1 other user. 

 Be asked to provide the additional user with your access code. After the shared-access 
user’s initial login to your PC, it is recommended that you change your access code. 

 

Access Codes for Shared Users 
When a secondary user is granted access to a host PC, he or she inherits the owner’s access 
code from the time the invitation was granted. The secondary user will use this access code even 
if the owner changes his access code after sending the invitation.  If the original access code is 
forgotten by both the secondary user and the owner, then the administrator will need to revoke 
the original invitation and grant a new one so that the secondary user can inherit the new access 
code. If the secondary user has physical access to the host PC, he can change the access code 
by following the steps described in the Forgot Host PC Access Code section. 

Note: If a shared access user fails to log in after 3 attempts, all users who have access to that PC will be locked out. 
Contact your administrator to unlock the Shared Access host PC.  

If you have any questions about shared access to your PC, please contact your administrator. 

  

In-Session Reboot  
The In-Session Reboot feature enables you to remotely reboot your host PC and log back in with 
your Windows login credentials. This is an exclusive feature to accounts that have the Shared 
Access feature enabled. Since the In-Session Reboot feature is not a default setting, it must first 
be enabled by your administrator at the user or group level in the GoToMyPC Administration 
Center.  
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What to Do When Your Host PC is Offline 
If you log in to your GoToMyPC account and see that the My Computers page is showing that 
one of your PCs is Offline, then one of three conditions, or a combination of conditions, may 
exist. The three conditions are: 

 The host PC is powered off. 

 The host PC is not connected to the Internet. 

 The GoToMyPC host software is not running. 

 

 To start the GoToMyPC service 

 From the taskbar, choose Start, Programs, Citrix and then GoToMyPC. 

 

What it means when your Host PC is In Session 
If you log in to your GoToMyPC account and see that the My Computers page is showing that 
one of your PCs is In Session, then one of three conditions, or a combination of conditions, may 
exist. The three conditions are: 

 You have not reloaded the My Computers page since you last connected to your host PC.  
Click the browser refresh button to reload the page and the In Session notification 
should disappear. 

 The host PC has not yet sent notification to the Citrix Online servers that it is no longer 
in session. Wait a few minutes and reload the My Computers page and the In Session 
notification should disappear. 

 The PC is a shared PC and is being accessed by another user on the GoToMyPC account.  
If you click the connect button you will disconnect the user that is in session with the 
host PC. If you have any questions about shared access to your PC, please contact your 
administrator. 
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Upgrade GoToMyPC 
GoToMyPC will notify you when new updates are available. You can also 

check for new updates at any time by right-clicking the  system tray 
icon (usually located in the lower-right corner of your screen near the 
clock) and selecting Check for Upgrade.  If a new version exists, you will 
be notified and asked if you want to upgrade.  

Note: You can upgrade GoToMyPC versions 5.0 and higher while remotely connected to 
your host PC. 

If you want to upgrade, click Yes; if not, click No. If you click Yes, 
GoToMyPC will download the new version and prompt you to reinstall 
with the install wizard. 

Should the automatic upgrade fail, you will need to manually upgrade the service. Simply open a 
Web browser, go to https://www.gotomypc.com/setupSoftware.tmpl, login and follow the 
directions. 

Access Online Help 
You can access product help at anytime by selecting the Help link from the Viewer menu or from 

the  system tray icon. 

  

 

https://www.gotomypc.com/setupSoftware.tmpl
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Security Tips 
 

GoToMyPC provides stringent built-in security features so that you can confidently access your 
PC from anywhere. For added security, here are a few things you can do. 

1. Keep Your Password and Access Code Secure 

 Maintaining password security is the best way to protect your GoToMyPC account and 
host PC. Don’t share your password with anyone, and change your password 
regularly. You can change your access code from your host PC by right-clicking the   
system tray icon and selecting Change Access Code. 

 GoToMyPC requires that your passwords have at least eight characters that include 
letters and numbers. When choosing your passwords, do not use common or easily 
guessed words. For the highest level of security, your account password and host PC 
access code should be different. 

 When using shared or public computers, exercise special care by not using GoToMyPC 
Remember Me feature to log in automatically. Additionally, you should not use your 
Web browser’s "auto complete" feature. 

 Use the One-Time Passwords feature for additional protection when traveling and 
using public terminals.  

 Protect Your Host PC When Remotely Connected 

 Use the Blank Host PC Screen feature to prevent someone at your host PC from 
viewing your activity (most configurations). 

 Use the Lock Host Keyboard and Mouse feature to prevent others from using your 
host PC mouse and keyboard when you are remotely connected (this option available 
for most operating systems). 

2. Use Safety Features When Inviting Guests 

 You choose the expiration period for each invitation so you know when to be available 
when your guest arrives. The invitation expires if the guest does not connect to your 
host PC within your designated period. Because the invitation automatically expires, 
your guest cannot attempt to connect when you are away from your computer. 

 You choose the level of access to grant your invited guests. To limit a guest’s access 
to your computer, grant view-only control. Alternatively, you can allow full control of 
your keyboard and mouse. 

3. Completely Disconnect 

 Make sure to completely disconnect when you are finished by closing the Viewer and 
logging out of the GoToMyPC Web site. 

 Be certain that you do not leave the client computer while you are remotely connected 
to your host PC.  

 When you log out, remember that if you do not close the programs you were last 
working on, they will remain visible the next time you access your host PC. Make sure 
to close any sensitive documents or programs before you disconnect. 

 You can have GoToMyPC automatically lock your PC when you end your session. This 
prevents someone at your host PC from using your computer after you have 
disconnected. Enable this feature from the Security tab of GoToMyPC Preferences. 
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FAQs and Troubleshooting 

General FAQs 
 

Q. Can multiple accounts be set up on one host computer? 

A.  No. Multiple accounts cannot be set up on one host computer. If a computer is already 
registered to one account as a host and another user wants to add that same computer as a host 
onto their account, the first account will be overridden. In other words, the most recent user who 
added that computer to their account will have sole access. 

 

Q. I have two computers under my GoToMyPC account. Can I access both my 
computers at the same time? 

A.  Yes, you may access two different computers at the same time. To do this, wait for a 
connection to be established on one computer and then go back to our GoToMyPC Web page and 
connect to the other computer. Please note that you may experience an increased lag time due 
to the multiple connections. 

 

Q. What are my subscription options once my GoToMyPC plan expires?  

A.  If you pay for your GoToMyPC service with a credit card, you can now manage your 
subscription online and pre-select what happens to your account when your current plan expires. 
To modify your selection, log in to your account at gotomypc.com and select My Account from 
the navigation menu on the top left of your screen.  Next, select Billing Info and then scroll to 
the bottom of the page to Subscription Options. From here you can select whether the account 
should be renewed or cancelled at the end of your current plan.  

 

Q. Can I cancel my GoToMyPC account online? 

A.  Yes - if you pay for your GoToMyPC service with a credit card you can cancel your service by 
logging in to your account at gotomypc.com. Select My Account and update your subscription 
options on the Billing Info page. You can also call Customer Care toll-free at (888) 259-3826. If 
you are calling from outside the United States or Canada, please use one of our international 
telephone numbers.  

Because GoToMyPC is a pre-paid service, your service will continue until the end of your current 
paid subscription period. At that time, your plan will be discontinued and will not renew again. 
Depending on the timing of your credit card billing cycle, your final charge may appear on your 
next statement. Please note that there are no refunds for service. Your plan will continue until its 
normal end date. Log in to review the active dates of service for your account. 

 

Q. How do I install GoToMyPC on my new computer and take it off the old one? 

A.  To free up your GoToMyPC license, first log in to your GoToMyPC My Computers page. Click 
the link to edit the host PC you wish to remove and then click the Delete button. Next, go to 
your old host PC and uninstall GoToMyPC. Finally, log in to your GoToMyPC My Computers page 
from your new PC and install GoToMyPC. 
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Q. My company has the Shared Access feature enabled. Can I delete my host PC if it’s 
shared with another user? 

A.  No, you cannot delete your host PC if it is shared with one or more users. Your administrator 
must remove all shared-access users before you can delete the host PC from your account. 

 

Q. Is there a way to stop GoToMyPC from automatically launching? 

A.  You can start GoToMyPC manually by right-clicking the  icon and choosing Preferences. 
Under the Host tab, uncheck Automatically and then click OK.  

 

Q. Can GoToMyPC run without having the GoToMyPC icon active in the system tray? 

A.  No, GoToMyPC must be running in the system tray for you to access the host PC. 

 

 Setup FAQs 
 

Q. Can I install GoToMyPC 6.0 on a Windows 95, 98, ME or NT computer?   

A. No. GoToMyPC 6.0 must be installed on a PC with Windows 2000, XP or Vista. You can 
remotely connect to your host PC from computers with older operating systems. If installation is 
attempted on a PC with an older OS, you will be redirected to install GoToMyPC 5.0. Please see 
the System Requirements section for more information.   

 

Q. I tried to use your product, but cannot get past the window that asks for my user 
name and password. Help! 

A. In this case, you are stuck in the authentication loop. This usually means that the computer 
you are on is behind a firewall. Our product, currently, cannot get through some highly-selective 
firewall systems. As a possible work-around, in addition to the usual ports 80 and 443 that are 
used to access the Internet, we suggest opening port 8200. Please see 
www.gotoassist.com/iprange for current IP addresses. If you use personal firewall software, 
make sure GoToMyPC has been added to its list of software that is allowed to access the 
Internet. 

 

Q. The GoToMyPC icon in the system tray has a yellow exclamation point. What does 
this mean?  

A. The  icon generally indicates that you did not complete the set-up and installation process. 
Please right-click on our icon in the system tray and select Register. This will bring you back to 
where you previously quit the installation process. 

 

Q. Sometimes your icon on the bottom has a red "x." What does this mean? 

A. The  icon means that your computer is not connected to the Internet or cannot access the 
GoToMyPC servers. If the problem persists, check if there is a firewall (personal or Corporate) or 
proxy server. 

  

 

http://www.gotoassist.com/iprange
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Session FAQs 
 

Q. I get horizontal lines on my screen when I access the host PC. How do I get rid of 
this? 

A. You may see this if your host PC is scheduled to go into "Sleep Mode," has a screen saver or 
has an open DOS program. Click in the center of the viewer multiple times or access the Tools 
menu and then select Send Ctrl-Alt-Del to wake up the computer.  

 

Q. Why do I see a blinking cursor on the host PC? 

A. GoToMyPC is unable to blank the cursor with certain video cards. Try turning off the monitor 
on the host PC. 

 

Q. How can I transfer more than one file at a time?  

A. You can select more than one file at a time by holding down the Ctrl key while selecting files 
with the mouse. 

 

Q. The resolution is very bad. I can barely make out the icons on my desktop or read 
my email text. What can I do to clear this up? 

A. When you connect to a host PC with a resolution set higher than the client, GoToMyPC 
automatically condenses the host desktop image in the viewer. You can resize the image of the 
host PC's desktop from the View menu. You can also try modifying the host PC’s screen 
resolution in the Screen Properties control panel.  

 

Q. I am getting a bluish screen or purple boxes on my screen when I connect. 

A.  Right-click on the host PC’s desktop and select Properties. Click on the Settings tab, change 
the color to 16-bit and then click Apply. 

 

Q. I cannot connect from my client computer.  

A.  Be sure that the Java settings are enabled in the browser and then reboot. Modify any 
firewalls to accept GoToMyPC. See the HUUsing GoToMyPC with Firewalls for more information. 

 

Q.  I am running Windows XP and would like to switch users while connected to my 
host PC. Will I be disconnected or lose any information? 

A:  Fast User Switching allows you to connect to your host computer regardless of which user (if 
any) is active at that time.  Once connected to your host PC, you can switch users at any time; 
however, any queued or active file transfers and remote printing jobs in progress are terminated 
when a user switch is performed. A black screen with a status message is displayed when a user 
switch is taking place. We recommend that you avoid logging off your PC from the Task Manager 
Users Page when using Windows XP Fast User Switching since this may shut down GoToMyPC. 
Fast User Switching is available on XP and later, including Vista. 
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Q.  Why are the letters the wrong case (Shift and/or Caps Lock do not work properly) 
when the Input Blocking feature is enabled on Windows XP? 

A.  Some versions of Windows XP have an issue with Input Blocking. To resolve, install Windows 
XP Service Pack 2 or go to Windows Update and install all of the Critical Updates. 

 

Printing FAQs 
 

Q. I am trying to print checks with the GoToMyPC Printer but the alignment is off.  

A. Manually enable the client computer’s printer when precision printing is required. Please see 
the section titled Manually Enable a Printer for details. 

 

Q. I am unable to print to my Dell or Lexmark printer from my client computer  

A. Complete the following steps with administrative rights on the client computer:  

1. Click Start and select Settings and then Printers and Faxes. 

1. Right-click on the Lexmark or Dell printer you plan to use and select Properties. 

2. Select the Advanced tab and then click the Print Processor button.  

3. If the default is set to LEMF, change it to NT EMF 1.008. 

4. Click OK.  

Note: Changing the default data type to NT EMF 1.008 should allow you to use the GoToMyPC Printer for remote printing 
but it could impact your regular print projects. If you notice subtle differences in the color output or have problems with 
special printer features you will need to change the default data type back to LEMF. 

 

Q. I was trying to set up a remote printer and now I’ve lost my connection. 

A.  Some printers require a host PC reboot upon setup. This requires the GoToMyPC startup 
preference to be set to start automatically. Before you begin setting up remote printing, make 
sure GoToMyPC is set to start up automatically: Right-click the   icon in the system tray of your 
host PC and select Preferences and the Host tab. Under Start GoToMyPC, check "Automatically" 
and select "After startup." If your preference was set to start GoToMyPC manually and the 
printer you were setting up required a reboot, your connection will have been lost and the 
printer installation will have to be repeated. Physically go to your host PC and reboot. Navigate 
to the newly created printer by clicking Start, Settings, Control Panel and then double-clicking 
Printers and Faxes. Delete the new printer and restart the printer setup process. Administrator 
privileges may be required to remove the printer.  

 

Q. I am not sure which options to select in the Printer Setup Wizard during the printer 
setup process. 

A. Read and follow the tips in the GoToMyPC Printer Setup Wizard Tips window to the left of the 
Printer Setup Wizard window or review the Remote Printing section. 
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Q. I can’t find my printer manufacturer, printer or printer driver in the Printer Setup 
Wizard process. 

A. The Window's operating system you are running does not have your printer’s driver in its 
database. Download and install the printer driver from the manufacturer’s Web site and select 
the "Have Disk" option in the Printer Setup Wizard when prompted for the manufacturer and 
printer. 

 

Q. I can’t get GoToMyPC to recognize the printer driver. 

A. The printer manufacturer may require a custom installation. While remotely connected to your 
GoToMyPC host PC, download the driver for the client printer from the manufacturer’s Web site 
to the host PC. 

Install the driver on the host PC. The installation will depend on the install packaging of each 
driver so be sure to follow the manufacturer’s install instructions. When prompted for the printer 
port, accept the default selection. 

Once the installation is complete, click Start, Settings and then Printers. Right-click on the newly 
installed printer and click Properties. Click on the Ports tab. In the list of ports, select the 
"GoToPort". Click OK. 

It is recommended that you add GoToMyPC as a preface to the printer name. To do this, in 
Printers, right click on the newly installed printer and click Rename. Enter "GoToMyPC –" to the 
beginning of the name so you know that this printer is for GoToMyPC. 

From the GoToMyPC Viewer menu select Tools, Preferences and then the Printing tab. The new 
printer is listed as GoToMyPC Printer and you are ready to print from the client computer. 

 

Q. I receive an error message telling me that I do not have the proper permissions or 
"Administrator Rights" to install a printer driver. 

A. This is due to your user profile rights. You need to have administrator rights to install printer 
drivers. Please see Windows help or your network administrator for help ensuring you have 
administrator rights to install GoToMyPC. 

 

Q. I downloaded and installed the printer driver and completed the setup process, but 
it prints incomprehensible text. 

A.  You may have the wrong printer driver on the host PC for the client computer’s printer. 

Make sure the printer driver you installed on your host PC matches the printer model you are 
trying to print to on the client computer. Also, make sure you have the correct driver version for 
your operating system. 

  

Q.  I clicked the print icon on the toolbar of my application but it did not print to the 
client printer (or printed to the host). 

A. The GoToMyPC Printer may not be selected as the default printer while in session. To make 
the GoToMyPC Printer the default while in session, change the Printing preferences so the 
GoToMyPC Printer is automatically set as the in-session default. 

If you do not want the GoToMyPC Printer to be the in session default, you will need to print by 
going to File > Print in your application and select the GoToMyPC Printer. 
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Q. I receive the error message: “There was an error found when printing the document 
<document_name> to GoToPort:. Do you want to retry or cancel the job?”  

A. You are trying to print to the GoToMyPC printer when the GoToMyPC session is over. Some 
applications remember which printer was used the last time the document was printed. Print 
from the file command in your application and select a non-GoToMyPC printer.  

- or -  

The default printer was not restored after the GoToMyPC session ended. Open the Windows 
printer folder, select a non-GoToMyPC printer, and click Set as Default in the File menu. 

  

PocketView FAQs 
 

Q.  How do I install GoToMyPC PocketView? 

A.  You do not need to install PocketView. Once you have set up a GoToMyPC account and 
installed the software on your host PC, simply log in to the GoToMyPC Web site from your 
Windows Mobile, Pocket PC, or Windows CE device and choose the host PC you wish to connect 
to. You will then be presented with the download needed to connect to that computer.  

 

Q.  Do I have to download PocketView every time I connect to my remote computer? 

A.  You must download the loader program each time you connect, but it is only 50KB. Once the 
correct version of the main PocketView program (about 550KB) is downloaded, it will be cached 
on your device so it will not need to be downloaded again. To bypass the login screen and 
quickly begin a session, create a shortcut from the File menu. 

 

Q.  Can I pre-install PocketView? 

A.  PocketView is installed through download-on-demand. If you want to avoid going through the 
initial download while using a slower wireless connection, connect once while the device is in its 
cradle (using ActiveSync for the Internet connection). After that, the main program will be 
cached and will not need to be downloaded again.  

 

Q.  What kind of handheld device is needed to use PocketView? 

A.  PocketView supports Microsoft Windows Mobile 5.0 / 2003SE / 2003 for Pocket PC (including 
Phone Edition) and most devices running Windows CE 4.0 or later with a touchscreen or mouse, 
such as thin clients. For more detailed information, please see the System Requirements section. 

 

Q.  What kind of Internet connection is needed to use PocketView? 

A.  An Internet connection with a typical speed of at least 40 kbps is recommended.  
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Q.  How do I rotate the on-screen keyboard or other soft input panel? 

A.  If your device is running Windows Mobile 2003SE or later, you can rotate the screen using its 
built-in capability instead of using PocketView’s rotation.  From the Start menu, choose Settings 
> System > Screen to change the device’s orientation. 

 

Q.  How do I remove PocketView from my handheld device? 

A.  If you wish to remove the cached PocketView program, use File Explorer to navigate to 
Programs Files\Citrix\GoToMyPC; locate the g2viewer.exe file and tap-and-hold it; and then 
select Delete from the popup menu. 

  



GoToMyPC® User Guide 
 

 

© 2008 Citrix Online, LLC. All rights reserved.  61 
 

Using GoToMyPC with Firewalls 
Firewalls are configured to block outgoing and incoming communications unless you authorize 
the program to allow them. You can use GoToMyPC with firewalls (ZoneAlarm, Norton Personal 
Firewall, etc.) installed on either a host PC or client computer. The table below lists the 
application components that need to be authorized in order for GoToMyPC to run. 
 

For the Host PC (This is the PC you want 
to access from someplace else) 

For the Client Computer (This is the 
computer you use to access the host PC) 

Primary Files Additional Files Primary Files Additional Files 

g2comm.exe g2audioh.exe g2viewer.exe None 

g2fileh.exe g2pre.exe   

g2host.exe g2processfactory.exe   

g2mainh.exe    

g2printh.exe    

g2svc.exe    

g2tray.exe    

gopcsrv.exe    

 
These programs need to be admitted through three ports: 80, 443 and 8200. One-way TCP 
connectivity is needed (TCP outbound). Should you need to authorize specific IP ranges, our IP 
ranges can be found here: www.gotoassist.com/iprange. 
 

www.gotoassist.com/iprange
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Using GoToMyPC with a Firewall on a Host PC 

Setting up a firewall to enable GoToMyPC to work requires that you take a little extra time to 
configure your software to allow GoToMyPC to run without interruption. Setting up GoToMyPC to 
work with a firewall involves three steps. 

 To set up a firewall to allow GoToMyPC to run as a host PC 

Step One: Enable GoToMyPC to access the Internet 

The first time you run GoToMyPC on a host PC that has a firewall installed, you will set off the 
firewall and be prompted to allow GoToMyPC to access the Internet. 

1. Select the check box to "Remember the answer each time I use this program." 

2. Click Yes to enable GoToMyPC to access the Internet. 

 

Step Two: Enable GoToMyPC to be the host PC 

Before you can remotely access a host PC you will need to authorize your firewall to allow 
the following GoToMyPC files to access the Internet: g2audioh.exe, g2comm.exe, 
g2fileh.exe, g2host.exe, g2mainh.exe, g2pre.exe, g2printh.exe, G2ProcessFactory.exe, 
g2svc.exe, g2tray.exe, gopcsrv.exe, g2vistahelper.exe. 

You must be physically present to authorize these files on your host PC. 

1. When prompted for each component, select the check box to "Remember the answer 
each time I use this program." 

2. When prompted for each component, click Yes to enable each component to access the 
Internet. 

Note: Be sure to disable Host Screen Blanking and Keyboard Locking on the GoToMyPC security preferences 
window prior to connecting with that host PC. 

 
Step Three: Configure your firewall to accept all GoToMyPC files 

1. Open your firewall console and manually select the option to allow each of the above 
components. After doing this once, you should not need to repeat this process again. 
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Using GoToMyPC with Norton Internet Security Firewall on a Host PC 

 To set up a Norton firewall to allow GoToMyPC to run as a host PC 

1. While physically present, right-click on the Norton Internet Security  icon on your host 
PC’s system tray.  

2. Select Open Norton Internet Security from the system tray menu. 

3. Select Personal Firewall from the Status & Settings menu and click the Configure 
button. 

4. Select the Programs tab, locate GoToMyPC and then click Add. 

5. To begin adding files, click on g2audioh.exe and click Open. 

6. From the Program Control prompt select Permit from the drop down menu and click OK. 

7. Repeat these two steps to add the remaining GoToMyPC files:  

g2comm.exe  G2ProcessFactory.exe 
g2fileh.exe  g2svc.exe 
g2host.exe  g2tray.exe 
g2mainh.exe  gopcsrv.exe 
g2pre.exe  g2vistahelper.exe 
g2printh.exe 
 
 

Using GoToMyPC with Norton Transaction Protection on a Host PC 
If your version of Norton Internet Security has the Norton Transaction Protection feature 
enabled, you may need to adjust your Norton settings in order to view your host PC’s desktop. If 
GoToMyPC is installed on your host PC but you are unable to view your desktop while remotely 
connected please follow these instructions.   

 To set Norton Transaction Protection to allow GoToMyPC to run 

1. If you have not already done so, install GoToMyPC and attempt to remotely connect to 
your host PC. Norton's Transaction Protection allows the connection but will blank out 
your host PC's desktop. 

2. End the session and return to your host PC. 

3. While physically present, right-click on the Norton Internet Security  icon on your host 
PC’s system tray. 

4. Select Open Norton Internet Security from the system tray menu. 

5. Click on the Norton Internet Security tab at the top of the Norton window. 

6. From the Settings drop-down list, click the Norton Internet Security Options link. 

7. Click the Transaction Protection link from the left side of the window. 

8. Change the status to allow g2host.exe and then click OK. 
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Using GoToMyPC with ZoneAlarm Firewall on a Host PC 

 To set up a ZoneAlarm firewall to allow GoToMyPC to run as a host PC 

1. While physically present, double-click the ZoneAlarm  icon on your host PC’s system 
tray.  

2. Select Program Control from the menu on the left.  

3. Verify that you are viewing the Programs tab. 

4. Click the Add button on the bottom-right of the screen.  

5. Navigate to the GoToMyPC folder on your computer (C:\Program Files\Citrix\GoToMyPC). 

6. Highlight all of the GoToMyPC files in that folder and click Open to add the GoToMyPC 
files. 

7. Locate the GoToMyPC file in the Programs list, click the  icon in the Trust Level column 
and select Super. Repeat this step for each of the GoToMyPC files. 

8. Finally, click each  icon in the Access and Server columns that correspond to a 
GoToMyPC program and select Allow.  

 

Firewall Vendor Links 
If you need help configuring your firewall, please contact your vendor directly. We hope the links 
below may also assist you. 

Norton Internet Security and Personal Firewall 

McAfee Answer Center 

ZoneAlarm 

Pandasoftware  

PC Cillin 

Verizon Internet Security 

eTrust EZ Firewall & CA Firewall 

AOL Security Center – Firewall 

AOL Security Center – Anti-Spyware 

 

http://service1.symantec.com/SUPPORT/nip.nsf/docid/2003120510272036?Open&src=sg&docid=2003120409222336&nsf=nip.nsf&view=16c1d01d537bf4d188256d8e0076b346/0b00821f98643c5088256df2005e8fb4?opendocument&prod=norton%20personal%20firewall&ver=2004%20for%20windows%2098/me/
http://us.mcafee.com/root/support.asp?id=retail_userGuides
http://www.zonelabs.com/store/content/support/zasc/faqs.jsp
http://www.pandasoftware.com/com/support?sitepanda=particulares
http://esupport.trendmicro.com/support/consumer/kbtree.do
http://netservices.verizon.net/portal/link/help/item&case=21306
http://crm.my-etrust.com/CIDocument.asp?SimpleUI=1&GUID=A565073222B6442BBD9F6E77D7B47436&ExternalCallID=0&Ver=&AddBookmark=0&KDId=2850
http://help.aol.com/AIMhelp/search.do?cmd=displayKC&docType=kc&externalId=http--helpchannelsaolcom-kjumpadparticleId220668&sliceId=&dialogID=25093580&stateId=0%200%2025111040
http://help.aol.com/AIMhelp/dynamickc.do?externalId=http--helpchannelsaolcom-kjumpadparticleId219278&sliceId=&command=show&forward=nonthreadedKC&kcId=http--helpchannelsaolcom-kjumpadparticleId219278
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Troubleshooting Sound Issues 
 The Sound feature is available on host PCs with Windows 2000 or later. It is not available 

on PocketView or the Universal Viewer. 

 For optimal sound quality and to eliminate many sound problems, install the latest 
Windows Media Player on both the host PC and client computer.  

 In rare cases, GoToMyPC is unable to detect the loopback input correctly. Manually select 
the loopback input from the drop-down menu in the Sound Preferences window. Typical 
names for the loopback input are: Stereo Mix, Wave Out Mix, What U Hear, Stereo 
Mixer, Sum and Stereo. This does not apply to PCs with Windows Vista. 

 

 

 

 

 

 

 

 

 

 

 If the sound quality is poor, it might be because the Wave output is set to 100% on the 
host PC. Reduce the Wave output volume from the host PC Windows Volume Control 
panel. This does not apply to PCs with Windows Vista. 

 

 

 

 

 

 

 

 

 If the Sound feature is enabled but there is no sound, verify the speakers are securely 
connected to the client computer.  

 If you attempt to use Skype VoIP while remotely connected to your host PC, GoToMyPC 
may reconfigure the audio source which will disable the sound. To reactivate the Sound 
feature, turn sound off and then on by clicking the Sound button in the upper right 
corner of the Viewer window. This does not apply to PCs with Windows Vista. 

 If you receive the warning "Sound is still playing" upon disconnect after you disabled the 
music, GoToMyPC may be detecting sound at very low levels. This does not apply to PCs 
with Windows Vista. 
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Sound Cards 
A sound card provides the audio component to your PC and is required on both the host PC and 
the client computer in order to use the Sound feature. The host PC sound card needs to have a 
loopback input device so that the computer can record what it is outputting. GoToMyPC 6.1 is 
compatible with a wide variety of sound card types but there are a few compatibility issues: 

 A number of problems can be resolved by downloading and installing the latest driver 
from the sound card manufacturer’s Web site. See the instructions below to determine 
the sound card in your computer. 

 There are known compatibility issues with older SigmaTel sound card drivers. Try 
installing the latest sound card driver with loopback input support. This does not apply to 
PCs with Windows Vista. 

 On a few sound cards, GoToMyPC cannot capture sound if the host PC is muted or the 
sound volume is very low. If you have Realtek HD 88x or Soundblaster Audigy SE, 
uncheck "Mute speakers on (your PC name) while in-session" in the Sound Preferences 
window. This does not apply to PCs with Windows Vista. 

 Sound is not supported on host PC sound cards that do not have loopback input, which is 
typically an issue with USB sound cards. Installing the latest sound card driver may 
resolve this issue. This does not apply to PCs with Windows Vista. 

 To determine the sound card installed on your computer 

1. Click the Windows Start button and then select the Programs folder.  

2. Select Accessories, System Tools and then System Information.  

3. From the System Information window, click the + symbol next to the Components folder.  

4. Click Sound Device (or Multimedia and then Sound Device) and view the sound card 
details on the right.  

Note: In cases where Windows installed a compatible sound card device, the listed sound card may not be the exact 
manufacturer and/or model installed in your computer. 
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Contact Customer Support  
There are three types of GoToMyPC account. Please contact the support center best suited to 
support your version.  

 GoToMyPC — Secure remote access for individual users  

 GoToMyPC Pro — Secure remote access for teams and small companies  

 GoToMyPC Corporate — Secure remote access for small and medium-sized businesses 

GoToMyPC  
If you are experiencing problems with GoToMyPC or have questions, please contact: 

 Customer support: gotocustomercare@citrixonline.com  

 Billing questions: gotobilling@citrixonline.com 

 Feedback or comments: gotofeedback@citrixonline.com 

 To contact Customer Care by phone, please call: 

 

Country Toll-Free Direct Dial  

U.S. and Canada 888-259-3826 805-690-5750  

United Kingdom 0800-051-8895 001-805-690-5750  

Europe 00-800-5744-2340 001-805-690-5750  

Australia 0011-800-5744-2340 00111-805-690-5750  

Mexico 001-800-574-4234 001-805-690-5750  

India 000-800-100-3093 001-805-690-5750  

Asia-Pacific 0011-805-690-5750 001-805-690-5750 

*Toll-free service unavailable in some areas 

 

GoToMyPC Pro 
To contact Customer Care with any GoToMyPC Pro account or billing questions, please contact: 

 Customer support: gotopro@citrixonline.com 

 By phone, please call: 888-646-0020 

GoToMyPC Corporate 
If you are experiencing problems with GoToMyPC Corporate (you are a corporate customer with 
a dedicated account manager) or have questions, please contact your IT administrator or: 

 Customer support: support@citrixonline.com 

 

mailto:gotocustomercare@citrixonline.com
mailto:gotobilling@citrixonline.com
mailto:gotofeedback@citrixonline.com
mailto:gotopro@citrixonline.com
mailto:support@citrixonline.com
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